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Preface

This document describes the Tamino Reporting feature. Tamino Reporting is based on BIRT, the
Business Intelligence and Reporting Tools, which is an open source, Eclipse-based reporting system
that can generate both HTML and PDF output. The Tamino Reporting feature tightly integrates
BIRT with Tamino, leveraging the power of BIRT so that it can generate reports based on data
taken from Tamino, Software AG's high-performance XML server for storing, managing, publishing
and exchanging XML documents in their native format.

This document discusses the following topics:

Eclipse and BIRT

Installing Tamino Reporting

Creating a Report that Retrieves Data from Tamino

Running the Report with the Tamino Reporting Runtime Engine
Deploying the Report to an Application Server

Running the Report
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1 Eclipse and BIRT
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Eclipse and BIRT

The following topics are discussed in this chapter:

About Eclipse

Eclipse is an open-source multi-language Integrated Development Environment (IDE) whose
home is at http://www.eclipse.org/. Without any add-ons, Eclipse is a development environment
for Java, but its main asset is that it can be augmented with plugins that can turn it into a develop-
ment environment for almost anything, for example BIRT.A good starting point for getting to
know about Eclipse is the Wikipedia entry for Eclipse (IDE) (http://en.wikipedia.org/wiki/Ec-
lipse_%?28computing%29).

Tamino comes with a version of Eclipse that has been enhanced by the addition of Software AG's
base technologies. You should install this version of Eclipse if you intend to use the Tamino Re-
porting feature.

We now define some terms that are frequently used in connection with Eclipse.
Projects and Workspaces

The files that are created when working with Eclipse are contained in projects, which in turn are
bundled in workspaces. An Eclipse workspace is a folder at an arbitrary location in your file system,
though Eclipse suggests placing the workspace in a folder imaginatively called workspace under
Documents and Settings/<userid>on the drive where Eclipse was installed. When you create an
Eclipse project, a corresponding folder is created in the current workspace.

The Workbench and Perspectives

When using Eclipse, you work in the Eclipse workbench. A workbench window offers one or more
perspectives. A perspective represents a way Eclipse has been customized for a certain purpose. It
contains views and editors and offers certain commands in the Eclipse workbench menus and
toolbars. The Eclipse default perspective which is included in the Eclipse installation is the Java
perspective, which is designed to allow Java development. A perspective is added to Eclipse by
installing a feature, such as BIRT. A perspective usually offers an editor (the main window displayed
roughly in the center of the workbench) that shows the main object to be developed (for example
a Java class) accompanied by a set of views to support development. A typical view for Java de-
velopment might be a class hierarchy or a list of compiler messages.
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Eclipse and BIRT

The Business Intelligence and Reporting Tools (BIRT)

BIRT, a tool for generating and viewing reports, comprises:

* an Eclipse-based report designer;

" aruntime component, i.e. a viewer.

The data upon which a report is based is not hardcoded into the report; rather, the report contains
Java objects to supply the data to be aggregated, for example using JDBC to access relational
databases.

The following picture is taken from the BIRT Overview on the Eclipse BIRT Project Page:

Report Designer Report Engine
Data Charting
Transform, Engine
Services HTML
PDF
Generation Presentation Excel
Services Services = \Word
FowerPoint
b 1 T g PostScript
Report
Document

For a more thorough introduction to BIRT, see:

® the BIRT Project Page on the Eclipse web site, including free download;
* the BIRT/FAQ in the Eclipse Wiki.

Instructions for creating a BIRT report are contained in the BIRT Tutorial on the BIRT Project
Page. There is no tutorial about creating a BIRT report with charts. For an introduction, see the
Flash presentation of BIRT. Also see the Examples on the Eclipse BIRT Project Page. Each rptdesign
file can be downloaded into a report project's folder and be handled just like a self-written report
in Eclipse/BIRT.
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2 Installing the Tamino Reporting Feature

In the webMethods Installer, check (tick) the tick box Designer > Tamino XML Server > Reporting
x.y, in addition to any other selections that you may have made. The installation process will install
a customized Eclipse package that includes BIRT and the Tamino Reporting feature.




Installing the Tamino Reporting Feature

i‘.g!;l webMethods Installer 8.0

webMethods Installer 8
Copyright & 2008 Software AG, Darmstadt, Germany

and/or Software AG US4, Inc., Reston, VA, Umited 5tates of America,
and/or their suppliers. All rights reserved.

Select products for a custom installation, or select typical development installations: Typical Installations... |

F-I Adapters |
_____ ™ Blaze Advisor 6.5.2 Select Defaults | Clear All |

-7 Broker and JMS
----- ™ CentraSite 8.0 MI
#-[" Database Configuration
=¥ Designer
~ I~ Eclipse 3.4
#-[" Business Processes
E-I~ Composite Applications
----- [T Entirex 8.0
-~ ESB and Integration
- S0A Governance
=¥ Tarmino XML Server

¥ Repating 8.0

“7 Wieh Service Management 8.0
----- ™ weh Serices Stack 8.0
-~ Developer
H-[~ Documentation
----- ™ Entirex 8.0
-~ ESEB {Integration Server)
-~ ESE and Intearation Server
-7 eStandards
-~ Infrastructure
-l Language Packs Installed Yersion:
- My wehhethods Server = | Product Size:
- by webMethods User Interfaces TFatie B 12 MB

-[” Optimize
i | | Free Space: 50424 ME

T Bannr Carar

Selected Yersion:

= Back | MHext = | Cancel

J Note: Although the webMethods Installer automatically checks (ticks) the box Tamino XML
Server in the above selection menu, this procedure does not install the Tamino XML Server.
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3 Creating a Report that Retrieves Data from Tamino

> To create a report that retrieves data from Tamino

Perform this procedure in the customized Software AG Eclipse environment.
1 Create a Reporting Project.
From the Eclipse workbench, choose the menu entry File > New > Project....

The "New Project" wizard is started. In the list of wizards (shown below), select Business
Intelligence and Reporting Tools > Report Project.




Creating a Report that Retrieves Data from Tamino

= New Project |:|E]

Select a wizard —

Creates a new Report Project, [

Wyizards:

|t~,-'|:ue Filker bext

L§ Jawa Project
# lava Praject from Existing Ank Buildfile
lgfﬁ Plug-in Project
= General
=== Business Inteligence and Reporting Tools
@? QD8 Designet Plug-in Project
'&%, QD8 Runkime Driver Plug-in Project
Eﬂ} Feport Project
= Vs
[~ Edipse Madeling Framessork
= EJB
= JZEE
= Java
L= P8,

| >

e e R

[ £

®

Choose Next.

In the next window, specify the name of the project.
2 Create a Report.
In the Eclipse navigator, select your newly-created project. From the context menu (right
mouse button), choose New >Report. In the following window, specify the name of the report.
3  Create a Data Source.

In the Eclipse reporting perspective, go to the Data Explorer view, select Data Sources, then
from the context menu (right menu button) select New Data Source.
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Creating a Report that Retrieves Data from Tamino

In the New Data Source wizard, ensure that the radio button Create from a data source type
in the following list is checked, then select Tamino Database.

& Mew Data Source

Select a Data Source Type or Choose a Connection Profile

Prowide all the settings for a new data source, or choose a pre-defined connection profile

{#) Create From a data source type in the Following list

{1 Create From a connection profile in the profile stare

Classic Models Inc, Sample Database
Flat File Data Source
JDEC Daka Source

ScriEted Daka Source

Web Services Data Source
*ML Data Source

Daka Source Mame: | Daka Source

(7 [ Finish ][ Cancel

Choose Finish.

4  Create a Data Set.
Select the data set. From the context menu, choose New Data Set.

In the next window, you can specify the data set's name, source and type:
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Creating a Report that Retrieves Data from Tamino

= New Data Set

Meys Data Set

Cefine the data set's name, source, and tvpe

Ciaka Sek Mame: | Data Set

Ciaka Source: Ciaka Source

Data Set Type: | Tamino Database

In the next window, you can enter a query. The query should not use a serialization specific-

ation in the query prologue, nor should it include updating expressions:
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Creating a Report that Retrieves Data from Tamino

= New Data Set

Specify XQuery

ey

collection{"dictletter|

lDeIete Querv] [Lu:uau:l... ] [F‘aste]

[ ] Preview First I:I lines of source data

T T

If the query returns a long list of results, you can use the Preview first nnlines of source data
facility to limit the output.

If a database URL has not yet been specified, the first time you run a query the Eclipse prefer-
ence dialog will prompt you to specify the target database:
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Creating a Report that Retrieves Data from Tamino

& Preferences |:|E

| Tamino Database List

General W Add, edit or remove Tamino dakabase entries, add

Ank These entries are offered if a Tamino database should be selected.

Conneckivity ;
Help Database Mame Database Ll Descripkion Edit...

Install{Update Remove
Internet =
Java
IPA
Flug-in Development
Report Design
Run/Debug
Server
S0L Developrent =
Taming

Tamino Database Li:
Tearn

Walidatinn

< |

e e R

[0 B

[

-

[

Choose Add... to add a new database URL, in the form http://<server-uri>/tamino/<database>:

& Add Database Entry [5_<|

Dakabase Mame: | dickdb |

Database Ul | Rtk BEEE faminodickdb |

Descripkion: | Dictionary Database |

[ oK ” Cancel l

A pop-up now prompts you to choose select the database that is to be queried:
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Creating a Report that Retrieves Data from Tamino

& Select Tamino Database

Select Tamino Database

Daka Source | htbpe i 000 fkamino/dickdb

= Back l[ Mexk = ]

5 Put a table into the report and include the data from the data set.

In the next window, specify the element that should become the anchor of the intermediate
result table:
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Creating a Report that Retrieves Data from Tamino

= New Data Set

Define Table Mapping

Select the element of the ¥ML struckure that is to be mapped ko a kable,

%ML Skruckure Table Mapping
[= resulk #Path expression:
=) lekter
o |

ket
def
elinks
links

Cancel

In the next step, specify the columns that should be included in the table:
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Creating a Report that Retrieves Data from Tamino

£ New Data Set |:|®
Define Column Mapping

Specify the elements of the XML structure that are to be mapped ko table colurmns.,

AML Skruckure Colurnn Mapping

term Mame #Path Type
= def kerm Jentryiterm Skring
acr

href fentryfelinksfeli...  String
dictk

<new mapping h. ..
br

[=)- ol
=i

[

dick

= elinks
=) elink B .
=-a

ERINE

@href

54
|
W

Table Preview

(2] Finish ] [ Cancel

6  You can now check your work by choosing Preview Results. This should show the result of
your query:
Tamino Reporting
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Creating a Report that Retrieves Data from Tamino

& Edit Data Set - Data Set

| #

Daka Source
“uery

Source Selectior
Table Mapping
Zolurnn Mapping
Cutput Columns
Compuked Calun
Parameters
Filkets

Property Bindinc
Settings

Prewview Resulks

Preview Results

kerm

ABQLAcrobat Reade, ..

e-businesseb¥MLEd]. ..
B2EBatikEase64BDE, .,

C#CALSCandidate R,

DAML+OILDASLAS, ..

FAQFOFOPFORCEFD, .,
Gamelanzeckageneti. ..

HaskelHokJavaHaks., .

IETWSHICEICE Brow. .,

J++J2EE125EJadab, ..

LarkListBotLaogickran. ..
MathMLMediatoriMet. .

nameservernamespd. ..

OASISODEBCCmniMa, ..
PanoramaPassiveTe. ..
QuickSilverQuilbQuiP

RODLRDFRegexpRE. ..
38A13ablotron3and. ..

TAGTaminoTargusthi, .,
LELUDDIUDDI4IUFD,

href

hiktpe fflisks. w3, org). .
hkkpe ey 2beml, L
htkpe ) el apache. ...

hikkpe | e, bitrill. .
hkkpe f e w3, org.

http:ffxml. apache, ...
hkkpe ) ey, devela,

hkkpe ) e haskell, .
hkkpes f e, coilorg.

htkp: ) fiava.sun.ca...

hikkpe | e, besckuali.,
hkkpe | e w3, org.,
hkkpe f e w3, org.
hkkp: | fvavaw, Dasis-o,
hikkpe f ey bei-coor,
hkkpe e, broady. .
hkkpe ) v, openhie. .

htkp: ) fiava.sun.ca...

hkkp: v w3, 0rg,
hikkpe f e, 0asis-o, .,

- BX

[

| £

l [ Cancel

In general, the options provided here correspond to the Tamino Reporting project, but the

option Source Selection allows you to query from another database.

Choose Finish. You should now see the fields that you selected for the internal table, i.e. the
output columns, beneath the data set's entry in the Eclipse Data Explorer view:
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Creating a Report that Retrieves Data from Tamino

L 1 Lk - ol L] “&=B s e

rEE Cutlin 238 £ F‘an:lc:.aw 'Eg Hierar\l =0 r *riew_repaort
= new_report, rptdesign _| 0
Elljj"l Data Sources
- EI Data Source
= [# Data Sets
SR Dt 3 Set

=

:
[ % R b

You can now use the data in a report. The easiest way to do this is to open the Eclipse Palette view,
drag a table (2 columns) into the report editing area, then drag the two data fields into the detail
row cells. Save the report, then preview it. It should show the data in the report:
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Creating a Report that Retrieves Data from Tamino

term
ABRCQL
Acrobat Eeader
Active Desktop
Arctved
ActrveX Control
ADABAS
Adept
Adobe
Alfred
ATAT
alpha'W orlcs
Altova
Amaya
Ant
Antenna House

£

http flists w3 orglArchivestdemberiwic-archive/20000 ctfatt-0192/0 1 - quilt
httpfwrwrw adobe comfproductsfacrobatireadstep 2 html

httpfiwrwrw microsoft comfcomitechiactives asp

http ffwrwrw softwareag comfadabas/

http fiwrarer. arbortext. comiProductsiproducts htrnthttp e arbortest. comd]
httpfiwrwrw adobe comf

http ffwrwrwr. opentesxt. com/

http fiwrarer. adaptivepath. comipublications/essaysfarcluve s/000285 phphttp
httpfiwrwrwr alphaworks thin comMliscialphaWorkes txt

http ffwrwrer szmlspy. comicompany. html

http fiwrwrwr w3, orglAmaval

httpffakarta apache. orgfant/

http ffwrarer. antennahouse. comthome. htrnlhttp e antennahouse. corslfo:

Lavout | Master Page | Script | ML Source | Preyiew
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4 Deploying the Tamino Reporting Runtime Engine

Eclipse and BIRT are necessary parts of the software that creates Tamino reports, and you can use
the integrated preview facility at any time in order to view your report. However, it may be desir-
able to view reports in environments where Eclipse and BIRT are not available. Tamino provides
an enhanced BIRT runtime engine that allows you to do this. The Tamino Reporting runtime engine
is a web application, in other words a WAR (web archive) file that is deployed under an application
server, for example Tomcat. Tamino includes a version of the BIRT report engine that is aware of
the additional parameter URL. This software is named TaminoReportEngine.

To run Tamino reports outside of Eclipse, copy the file TaminoReportEngine.war from the folder
$INODIR\ $INOVERS\Files into the Software AG Common Tomcat folder webapps. Stop and restart
Tomcat in order to unpack the WAR file and create a new folder named TaminoReportEngine.

Having prepared the runtime environment (application server) by deploying the Tamino Reporting
Runtime Engine, you can now run reports on that application server. The next step is to deploy
the report to the prepared application server, as described in the next chapter.
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5 Deploying the Report to an Application Server

Before deploying a report to an application server, the server must be prepared by deploying the
Tamino Reporting Runtime Engine to it. This is described in the previous chapter.

In order to run a Tamino report with the TaminoReportEngine, the report's rptdesign file must be
present in the folder webapps/TaminoReportEngine of the appropriate application server. There are
two ways of doing this:

® Copy it manually from the appropriate project folder in the Eclipse workspace; alternatively:

® Choose Deploy Report from the report's context menu in the Eclipse Package Explorer view:
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Deploying the Report to an Application Server

& Java - Reports/new_report.rptdesign - Eclipse SDK

File Edit Source Refackor Insert  Element Data Page M
=k 1 s 1 1
L = @ B0 e
5= outlin | 25 Palett | 2 Packa 53 = O nEw _repo
53 [—] {f& ~ 0

= IEH Reports - I

E Mew »

Qpen F3
Cpen Wikth 3
Shaow In ale+Shift+iy #
= Copy k|
oy
=) Paste Chrl+Y
¥ Delete Delete
Euild Path »
Refactar alk+shift+T  F
Eoy Import, ..
iy Export...
< Refresh FS
fssign Working Sets. ..
Yalidate

Deploy Repork
Fun fs »

This opens the Save As dialog. Browse to Software AG Common Tomcat > webapps > TaminoRe-
portEngine, then save the report file.
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6

Running the Report

> To run the report with the TaminoReportEngine

(i.e. typically in an environment that does not have Eclipse)

1
2

Start a web browser.

In the browser's address (URL) field, enter the URL of the Tamino report engine and specify
2 parameters:

1. the name of the report file (rptdesign file);
2. the URL of the Tamino database from which the report should fetch its data.

| Note: Additional report parameters may be specified as necessary.

Example:

http:// localhost:8080/ TaminoReportEngine/ run?__report=new report.rptdesign& UR=http://pcxyz/ tamino/ dictab
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